**Type 8923**

Bürkert Communicator

Software tool for communication for Bürkert devices
Software zur Kommunikation für Bürkert-Geräte
Logiciel de communication pour appareils Bürkert

Operating Instructions - Software
Bedienungsanleitung - Software
Manuel d'utilisation - Logiciel
Communicator Type 8920

CONTENTS

1 THE OPERATING INSTRUCTIONS .................................................................................................................. 6
  1.1 Symbols .................................................................................................................................................. 6
  1.2 Definitions of terms ................................................................................................................................. 7

2 AUTHORIZED USE ...................................................................................................................................... 7

3 GENERAL INFORMATION ............................................................................................................................ 7
  3.1 Contact address ..................................................................................................................................... 7
  3.2 Information on the Internet .................................................................................................................... 7

4 PRODUCT DESCRIPTION ............................................................................................................................. 8

5 USER INTERFACE ........................................................................................................................................ 9
  5.1 Areas of the user interface ...................................................................................................................... 9
  5.2 Tool bar ................................................................................................................................................. 10
  5.3 Menu bar ............................................................................................................................................... 11
  5.4 Navigation area ................................................................................................................................... 13
    5.4.1 Desktop - Customizable area ........................................................................................................... 14
    5.4.2 Graph - Graphical display of values ................................................................................................. 17
    5.4.3 Interface ......................................................................................................................................... 18
    5.4.4 Devices or products .......................................................................................................................... 18
    5.4.5 Configurations ................................................................................................................................. 19
  5.5 Application area .................................................................................................................................. 20
    5.5.1 Devices or products .......................................................................................................................... 20
    5.5.2 Configurations ................................................................................................................................ 21
    5.5.3 Tab parameters ................................................................................................................................. 22
    5.5.4 Tab diagnostics ................................................................................................................................. 22
    5.5.5 Tab maintenance ............................................................................................................................... 22

6 INSTALLATION SOFTWARE ....................................................................................................................... 23
  6.1 System Requirements ............................................................................................................................. 23
  6.2 Install Communicator ............................................................................................................................. 23
7 CREATING A PROJECT ......................................................................................................................................... 24
  7.1 Start Communicator ....................................................................................................................................... 24
  7.2 Add interface ................................................................................................................................................... 24
  7.3 Make settings on device or product .................................................................................................................. 26
  7.4 Save project or ................................................................................................................................................ 27

8 OPERATION AND FUNCTIONS .......................................................................................................................... 28
  8.1 Edit project ....................................................................................................................................................... 28
    8.1.1 Open or close project .................................................................................................................................. 28
    8.1.2 Add or disconnect interface ........................................................................................................................... 29
    8.1.3 Read in data .................................................................................................................................................. 29
    8.1.4 Backup and restore device configurations .................................................................................................... 30
  8.2 Settings in the Communicator ........................................................................................................................... 32
    8.2.1 Set language ................................................................................................................................................ 32
    8.2.2 Select system of units and units ................................................................................................................... 32
    8.2.3 Keep or remove graph when connection is interrupted ............................................................................ 34
    8.2.4 Manage licenses ....................................................................................................................................... 36
    8.2.5 Activating password protection or define password ................................................................................ 36
  8.3 Information and Help ...................................................................................................................................... 38
    8.3.1 Help ........................................................................................................................................................... 38
    8.3.2 Driver versions ........................................................................................................................................... 38
    8.3.3 Software information and manufacturer’s address .......................................................................................... 38
    8.3.4 Logbook file ............................................................................................................................................... 38
  8.4 büS network configuration ................................................................................................................................. 39
    8.4.1 büS-Map..................................................................................................................................................... 39
    8.4.2 Processing büS network configuration with büS-Map .............................................................................. 41
  8.5 Customize desktop ............................................................................................................................................ 43
    8.5.1 Edit or Backup desktop ( or ) ...................................................................................................................... 44
    8.5.2 Insert process value as a widget .................................................................................................................. 44
    8.5.3 Insert graphical elements or texts .............................................................................................................. 45
    8.5.4 Change widgets, graphical elements or texts ............................................................................................ 46
8.6 Graph

8.6.1 Auto-fit graph

8.6.2 Scale axes

8.6.3 Change graph color

8.6.4 Save graph in a logfile (database)

8.6.5 Open or close databases

8.6.6 Other functions

9 UNINSTALL COMMUNICATOR

10 GLOSSARY
1 THE OPERATING INSTRUCTIONS

The operating instructions describe basic operation of the Bürkert Communicator. Keep these instructions in a location which is easily accessible to every user and make these instructions available to every new owner.

⚠️ WARNING!

Safety Information.

Safety instructions and information for using the communication-capable devices or products may be found in the corresponding operating instructions.

Failure to observe these instructions may result in hazardous situations.

▶ The operating instructions must be read and understood.

1.1 Symbols

⚠️ DANGER!

Warns of an immediate danger.

▶ Failure to observe the warning will result in a fatal or serious injury.

⚠️ WARNING!

 Warns of a potentially dangerous situation.

▶ Failure to observe the warning may result in serious injuries or death.

⚠️ CAUTION!

Warns of a possible danger.

▶ Failure to observe this warning may result in a moderate or minor injury.

NOTE!

Warns of damage to property.

▶ Failure to observe the warning may result in damage to the device or the equipment.

⚠️ Indicates important additional information, tips and recommendations.

📖 Refers to information in these operating instructions or in other documentation.

▶ Designates instructions for risk prevention.

→ Designates a procedure which you must carry out.

✔ Indicates a result.
1.2 Definitions of terms

The term "device" or "product" used in these instructions always refers to communication-capable devices or products.

2. AUTHORIZED USE

Non-authorized use of the Bürkert Communicator may be dangerous to people, nearby equipment, and the environment.

The software Bürkert-Communicator is designed for the communication for Bürkert devices.

▶ Use according to the authorized data, operating conditions, and conditions of use specified in the contract documents and operating instructions of the corresponding devices or products.

▶ Use the software only in conjunction with third-party devices and components recommended and authorized by Bürkert.

▶ Correct installation and careful use and maintenance are essential for reliable and faultless operation.

▶ Use the software only as intended.

3. GENERAL INFORMATION

3.1 Contact address

Germany
Bürkert Fluid Control Systems
Sales Center
Christian-Bürkert-Str. 13-17
D-74653 Ingelfingen
Tel. + 49 (0) 7940 - 10 91 111
Fax + 49 (0) 7940 - 10 91 448
E-mail: info@de.buerkert.com

International
Contact addresses can be found in the internet at:
www.burkert.com

3.2 Information on the Internet

The operating instructions and data sheets for device types can be found on the Internet at:
www.burkert.com
4 PRODUCT DESCRIPTION

The Software Bürkert Communicator for the communication with Bürkert devices permits convenient setting and monitoring of application-specific parameters.

Features:
• Configuring Bürkert devices with serial interface or büS service interface.
• Configuring of Bürkert büS networks.
• Graphical display of process values.
• Saving and displaying recorded measure values.
• Device firmware update.
• Backup and restoring of device configurations.
5 USER INTERFACE

5.1 Areas of the user interface

Menu bar

Device or product identification

Quick access tool bar for commands

Slide control for enlarging or reducing the user interface

Navigation area

Area of application

Many icons have tool tips (brief explanation) that describe the commands.
If a command is not available, it is grayed out.
### 5.2 Tool bar

The most important commands can be found in the tool bar. These and also additional commands can be found in the menu bar (refer to chapter entitled "5.3 Menu bar").

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open project" /></td>
<td><strong>File / Open project...</strong></td>
<td>Opens an existing project.</td>
</tr>
<tr>
<td><img src="image" alt="Recent projects" /></td>
<td><strong>File / Recent projects...</strong></td>
<td>Opens a drop-down list containing the recently opened projects.</td>
</tr>
</tbody>
</table>
| ![Save project](image) | **File / Save project as...** | Saves the current project.  
Note: This command is not active when a project is saved for the first time. |
| ![Add interface](image) | **File / Add interface...** | Adds a new interface. |
| ![Disconnect interface](image) | **File / Disconnect interface** | Disconnects a current interface. |
| ![Back](image) | **Edit / Undo** | Undoes the last change made. |
| ![Forward](image) | **Edit / Redo** | Repeats the last change made. |
| ![Refresh](image) | **View / Refresh** | The current values of the device or product are read in by the Communicator. |

Table 1: Description of tool bar

A detailed description of the commands can be found in the chapter entitled "8 Operation and functions".
## 5.3 Menu bar

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command or submenu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>Open project...</td>
<td>See description in chapter &quot;5.2 Tool bar&quot;</td>
</tr>
<tr>
<td></td>
<td>Save project</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Save project as...</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Add interface...</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disconnect interface</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Load database...</td>
<td>Imports a database</td>
</tr>
<tr>
<td></td>
<td>Close</td>
<td>Closes the project and the Communicator.</td>
</tr>
<tr>
<td><strong>Device</strong></td>
<td>Backup or restore device configuration</td>
<td>The device configuration can be exported, imported, copied or overwritten.</td>
</tr>
<tr>
<td></td>
<td>Start automatic firmware update...</td>
<td>Updates the firmware of the device or product to the current status.</td>
</tr>
<tr>
<td></td>
<td>Load firmware update from file...</td>
<td>Imports a firmware update from a file.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Undo</td>
<td>Undoes the last change made.</td>
</tr>
<tr>
<td></td>
<td>Redo</td>
<td>Repeats the last change made.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Refresh</td>
<td>The current values of the device are read in by the Communicator.</td>
</tr>
<tr>
<td></td>
<td>Language</td>
<td>Selection of predefined languages in the menus, tool bar, navigation area and application area.</td>
</tr>
<tr>
<td></td>
<td>System of units</td>
<td>• Selection of the system of units (metric / U.S. / Imperial)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Selection of specific units for a size (m, mm, ...).</td>
</tr>
<tr>
<td></td>
<td>Snap widgets to grid</td>
<td>Widgets, graphical elements or texts inserted on the desktop can be aligned to the grid.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;During moving&quot; and/or &quot;During fitting&quot;.</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td>Remove graphs with device</td>
<td>If the connection to the device / product is interrupted, the following selection is available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Keep or remove graph.</td>
</tr>
<tr>
<td></td>
<td>License manager...</td>
<td>• Displays the assigned licenses and the corresponding activated functions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Add further licenses.</td>
</tr>
<tr>
<td></td>
<td>Password manager...</td>
<td>• Activating or deactivating password protection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Define a password to protect settings.</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td>Open logbook file</td>
<td>Opens a saved device logbook.</td>
</tr>
</tbody>
</table>

**English**
### Table 2: Description of menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command or submenu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Help</td>
<td>Displays these operating instructions.</td>
</tr>
<tr>
<td>Driver versions</td>
<td></td>
<td>Displays the installed devices / products, the corresponding driver versions and the supported types.</td>
</tr>
<tr>
<td>About...</td>
<td></td>
<td>Displays version number and manufacturer’s address</td>
</tr>
</tbody>
</table>

A detailed description of the commands can be found in the chapter entitled "8 Operation and functions".
5.4 Navigation area

The various contents for the application area can be selected in the navigation area:

![Navigation area (example)](image)

**Figure 3: Navigation area (example)**
5.4.1 Desktop - Customizable area

The user can customize the desktop according to his preferences using widgets, graphical elements and texts.

Figure 4: Desktop (example)
The user can use the tool bar to insert values, graphic elements, text fields and images in the application area.

A detailed description of the functions can be found in the chapter entitled "8.5 Customize desktop".

Figure 5: Tool bar
## Communicator Type 8920
### User interface

<table>
<thead>
<tr>
<th>Icon</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Tool bar" /></td>
<td>Open tool bar (desktop is pinned)</td>
</tr>
<tr>
<td><img src="image" alt="Close tool bar" /></td>
<td>Close tool bar and pin desktop.</td>
</tr>
<tr>
<td><img src="image" alt="Copy screen shot" /></td>
<td>Copy screen shot to clipboard.</td>
</tr>
</tbody>
</table>
| ![Insert graphic or picture](image) | • Insert a graphic or picture from a file.  
• Insert a device picture. |
| ![Insert text field](image) | Insert a text field. |
| ![Insert shapes](image) | Insert shapes. |
| ![Insert empty graph](image) | Insert an empty graph. |
| ![Insert process value](image) | Insert a process value as a widget. |

### Display icons
<table>
<thead>
<tr>
<th>Icon</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Rotate element" /></td>
<td>Rotate element.</td>
</tr>
<tr>
<td><img src="image" alt="Bring element to front" /></td>
<td>Bring element to front.</td>
</tr>
<tr>
<td><img src="image" alt="Send element to back" /></td>
<td>Send element to back.</td>
</tr>
<tr>
<td><img src="image" alt="Delete element from desktop" /></td>
<td>Delete element from desktop.</td>
</tr>
<tr>
<td><img src="image" alt="Change color of outline and fill of shapes and texts" /></td>
<td>Change color of outline and fill of shapes and texts.</td>
</tr>
<tr>
<td><img src="image" alt="Change color of outline" /></td>
<td>Change color of outline and fill.</td>
</tr>
<tr>
<td><img src="image" alt="Change color of fill" /></td>
<td>Change color of fill.</td>
</tr>
<tr>
<td><img src="image" alt="Define outline width" /></td>
<td>Define outline width.</td>
</tr>
<tr>
<td>Icon</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Change display style.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Change display accuracy.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Enlarge or reduce an element.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Change unit of a measured variable.</td>
</tr>
</tbody>
</table>

*Table 3: Tool bar and display icons*
5.4.2 **Graph** - Graphical display of values

Process values of a device can be displayed in the graph.

![Graph Example](image)

**Figure 6:** Graph (example)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Enlarges axis scaling." /></td>
<td>Enlarges axis scaling.</td>
</tr>
<tr>
<td><img src="image" alt="Reduces axis scaling." /></td>
<td>Reduces axis scaling.</td>
</tr>
<tr>
<td><img src="image" alt="Deletes values up to the current point in time from the graph." /></td>
<td>Deletes values up to the current point in time from the graph.</td>
</tr>
<tr>
<td><img src="image" alt="Saves the graphs in a database." /></td>
<td>Saves the graphs in a database.</td>
</tr>
<tr>
<td><img src="image" alt="Saves a screen shot of the graphs on the clipboard." /></td>
<td>Saves a screen shot of the graphs on the clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="AutoFit" /></td>
<td>The graphs are adjusted to the view (the axes change the scaling).</td>
</tr>
<tr>
<td><img src="image" alt="Roll" /></td>
<td>Graphs roll. Only possible for x-axis.</td>
</tr>
</tbody>
</table>

**Table 4:** Functions in the graph

A detailed description of the functions can be found in the chapter entitled "8.6 Graph".
5.4.3  Interface

The interfaces must be added by the user. The devices or products connected to the interfaces are then automatically added in a subfolder per device or product in the navigation area.

![Diagram of Communicator interface]

Figure 7:  Interface (example)

5.4.4  Devices or products

The individual devices or products are arranged in a folder structure underneath the inserted interface in the navigation area.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function or description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Device icon]</td>
<td>Device</td>
</tr>
<tr>
<td>![Sensor icon]</td>
<td>Sensor</td>
</tr>
<tr>
<td>![Gateway icon]</td>
<td>Gateway</td>
</tr>
<tr>
<td>![Inputs/Outputs icon]</td>
<td>Inputs and/or outputs</td>
</tr>
<tr>
<td>![Controller icon]</td>
<td>Controller</td>
</tr>
<tr>
<td>![Display icon]</td>
<td>Display</td>
</tr>
<tr>
<td>![Actuator icon]</td>
<td>Actuator</td>
</tr>
<tr>
<td>![Accessories icon]</td>
<td>Accessories</td>
</tr>
</tbody>
</table>

![Diagram of Communicator interface with devices]

Figure 8:  Devices or products
5.4.5 Configurations

The configurations are arranged in a folder structure underneath the device or product in the navigation area. The configurations depend on the device or product.

The individual devices or products are arranged in a folder structure underneath the inserted interface in the navigation area.

Figure 9: Configurations
5.5 Application area

5.5.1 Devices or products

If a device or product has been selected in the navigation area, the parameter and values for this device or product are displayed in the application area.

Figure 10: Devices or products (example)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function or description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Parameter icon]</td>
<td>Parameter</td>
</tr>
<tr>
<td>![Output value icon]</td>
<td>Output value</td>
</tr>
<tr>
<td>![Input value icon]</td>
<td>Input value</td>
</tr>
</tbody>
</table>
5.5.2 Configurations

If a device or product configuration is selected in the navigation area, corresponding menus appear in the application area on the parameters, diagnostics and maintenance tabs.

Using tab headers, it is possible to switch between different tabs in the application area.

The indicated menus and also any changes by the user depend on:

- Password protection activated or deactivated.
- The active user level when password protection activated.

**Figure 11: Area of application, configurations, tabs (example)**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function or description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Sub-menu exists</td>
</tr>
<tr>
<td>●○○○</td>
<td>Wizard</td>
</tr>
<tr>
<td>&lt;</td>
<td>Back</td>
</tr>
<tr>
<td>Standard</td>
<td>Drop-down list</td>
</tr>
<tr>
<td>Flow</td>
<td>Text field</td>
</tr>
</tbody>
</table>

**Table: Area of application, configurations, tabs (example)**

- **COMMUNICATOR**
- **Device or product identification**
- **Tabs**
- **Menu**
- **Area of application**
5.5.3 Tab parameters

The tab ‘Parameters’ displays settings for the selected configuration area. The user can change settings here in the Menus.

The depiction and the contents of the application area depend on the respective device or product.

5.5.4 Tab diagnostics

The tab ‘Diagnostics’ displays information, settings or values for the selected configuration area, e.g. bus information, device information or status information. The user can’t change any settings here.

The depiction and the contents of the application area depend on the respective device or product.

5.5.5 Tab maintenance

The tab ‘Maintenance’ displays additional settings for the selected configuration area. The user can modify the settings or execute the functions with menus and wizards.

The depiction and the contents of the application area depend on the respective device or product.
6 INSTALLATION SOFTWARE

6.1 System Requirements

Hardware:
Processor: Dualcore processor
Working memory: At least 1 GB RAM,
Hard disk: At least 250 MB free storage space
Graphics resolution: At least 1024 x 768

Software:
Operating system Windows 7:
Microsoft .NET Framework 4.0

Administrator rights are required for installation.

6.2 Install Communicator

All installation programs area available on the Bürkert Homepage and on CD.

Before the installation, exit all programs that are open.

Operating system Windows 7:

Installation of the Communicator requires presence of the software platform: Microsoft .NET Framework 4.0 or higher.

Procedure to follow if "Microsoft .NET Framework 4.0" is not present yet on the target computer:
→ Download .NET 4.5.1 under http://go.microsoft.com/?linkid=9831986.
→ Start file.

Procedure Communicator Setup:
→ Download installation file that contains the Communicator Setup.
→ Start installation file and follow prompts.
7 CREATING A PROJECT

This chapter describes how to create and save an initial project.

Procedure (brief):

→ Start Communicator.
→ Add interface.
→ Make settings on device or product.
→ Save project.

7.1 Start Communicator

→ Start Communicator (e. g. from Windows start menu).

7.2 Add interface

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>File / Add interface...</td>
<td>Adds a new interface.</td>
</tr>
</tbody>
</table>

→ Click on

A dialog field for selecting the interface opens, and then a dialog field for making further settings opens:
→ Select interface.
→ Make settings.

The interface and the associated devices and products are transferred to the navigation area.
Creating a Project

**Dialog field for interface**

<table>
<thead>
<tr>
<th>New connection</th>
</tr>
</thead>
</table>

Which interface you want to use for the connection?

- **büS stick**
  Connect to a büS network with a büS stick

- **büS over network**
  Connect to büS network over Ethernet

- **HART adapter**
  Connect to device through serial HART adapter

**Transfer in navigation area (example):**

![Communicator Type 8920 Diagram](image)

*Figure 12: Add interface*

The following interfaces are possible:

- **Connection via a büS Stick:**
  Access a büS network directly via a Bürkert büS stick

- **büS via network**
  Access a büS stick connected to a different computer via a network

- **HART adapter**
  Access a device with serial connection via a USB HART adapter
7.3 Make settings on device or product

![Diagram of Communicator software interface]

Figure 13: Settings

→ Select device or product in the navigation area (click with mouse pointer).

✔ Folder structure opens and shows the configuration.

→ Select configuration.

→ Make settings in the application area.

The settings depend on the respective device or product and can be found in the software description of the device or product for the Communicator or in the respective operating instructions on the Internet.
7.4  Save project  or  

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🗂</td>
<td>File / Save project</td>
<td>Saves the current project.</td>
</tr>
<tr>
<td>🖼️</td>
<td>File / Save project as...</td>
<td>Saves the current project. The storage location is defined by the user.</td>
</tr>
</tbody>
</table>

Save

→ Click on 🗂️

✔️ The current project is saved.

Note: This function is not active when a project is saved for the first time.

Save under

Saves the current project, the storage location is specified by the user.

→ Click on 🖼️

A dialog field opens:

→ Select the location where the current project is to be saved.

Note: The file type is "Bürkert Communicator Project (*.bcproj)".
8 OPERATION AND FUNCTIONS

8.1 Edit project

8.1.1 Open or close project

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>File / Open project...</td>
<td>Opens an existing project.</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>Opens a drop-down list containing the recently opened projects.</td>
</tr>
<tr>
<td></td>
<td>File / Close</td>
<td>Closes the project and the Communicator.</td>
</tr>
</tbody>
</table>

Open project

→ Click on Open project.
A dialog field opens:

→ Select the corresponding drive, the folder or the location containing the project you wish to open.

→ Open project.

Note: The file type is "Bürkert Communicator Project (*.bcproj)".

Or:

→ Click on
A drop-down list of the last opened projects opens.

→ Select project from the drop-down list.

Or:

→ Double-click on the project you wish to open in Windows Explorer.

Close project

→ In the menu bar, click on File Close.
✓ The project and the Communicator are closed.

⚠ If the user has made any changes, a dialog field opens to either save or reject these changes.
8.1.2 Add or disconnect interface

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="File Icon" /></td>
<td>File / Add interface...</td>
<td>Adds a new interface.</td>
</tr>
<tr>
<td><img src="image" alt="File Icon" /></td>
<td>File / Disconnect interface</td>
<td>Disconnects an interface.</td>
</tr>
</tbody>
</table>

Add interface

→ Click on ![File Icon](image)

A dialog field for selecting the interface opens, and then a dialog field for making further settings opens:

→ Select interface.

→ Make settings.

✓ The interface and the associated devices and products are transferred to the navigation area.

Disconnect interface

→ Select interface in the navigation area (click with mouse pointer).

→ Click on ![File Icon](image)

✓ The current interface is removed from the navigation area.

Or:

→ Right-click on the interface in the navigation area and click on Disconnect interface in the context menu.

![Figure 14: Interface, context menu](image)

8.1.3 Read in data

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="View Icon" /></td>
<td>View / Refresh</td>
<td>The current values of the device or product are read in by the Communicator.</td>
</tr>
</tbody>
</table>
8.1.4 Backup and restore device configurations

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Device / Backup or restore device configuration</strong></td>
<td>The device configuration can be exported, imported, copied or overwritten.</td>
</tr>
</tbody>
</table>

In the menu bar:

→ Click on a device or product in the navigation area.

Or in the context menu:

→ Click on a device or product in the navigation area.

→ Click on `≡`.

Or:

→ Right click on a device or product in the navigation area.

The following context menu appears:

![Context menu device or product](image)

→ Click on **Backup or restore device configurations**.

✔ A wizard opens.

→ Select functions:

- Backup Export device configuration
- Restore Import device configuration
- Clone Copy device configuration
- Overwrite Overwrite device configuration
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
</table>
| **Backup** | Export device configuration. Save the device configuration in a file. | A wizard opens:  
→ Select storage location and designation for the device configuration.  
→ **Save**.  
→ **Ok**.  
✓ The device configuration is saved in a file.  
Note: The file type is “Device backup File (*.load)” |
| **Restore** | Import device configuration. Imports the device configuration from a file into the device or product. Note: The ident. number and serial number of the devices or products must match in the device configuration. | A wizard opens:  
→ Select storage location and device configuration.  
→ **Open**.  
→ Select values.  
→ **Ok**.  
✓ The device configuration is imported into the device or product.  
Note: The file type is “Device backup File (*.load)” |
| **Clone** | Copy device configuration. Imports the device configuration from a file into the device or product. Note: The ident. number of the devices or products must match in the device configuration. | A wizard opens:  
→ Select storage location and device configuration.  
→ **Open**.  
→ **Enter data via keyboard**: The user can input name, location and description of the device or product here. or:  
**Data from saved file**: Name, location and description are accepted by the file.  
→ Select values.  
→ **Ok**.  
✓ The device configuration is imported into the device or product. |
| **Overwrite** | Overwrite device configuration. Imports the device configuration from a file into the device or product. Note: The data is imported unchecked. | A wizard opens:  
→ Request password from Service. |

**Table 5:** Backup and restore device configurations
8.2 Settings in the Communicator

8.2.1 Set language

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View / Language</td>
<td>Selection of predefined languages in the menus, toolbar, navigation area.</td>
</tr>
</tbody>
</table>

Note: Made settings are ticked.
When Automatic is selected, the language of the operating system is used.

Set language:

→ View → Language.
→ Select language.
✔ Ticked.

Language change only takes effect after a restart of the Communicator.

→ Close and restart Communicator.
✔ The language is adjusted.

8.2.2 Select system of units and units

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
</table>
|      | View / System of units | • Selection of the system of units (metric / U.S. / Imperial)  
• Selection of individual units  
• Selection of the size of unit (m, mm, ... ) |

Note: Made settings are ticked.

Define system of units

→ View → System of units.
→ Select system of units.
✔ Ticked.

The units of the measured variables (distance, temperature, current ...) are set to standard values according to the selected system of units (ticked).
Define individual units or size of units

⚠️ In many widgets, units can be changed directly (for description refer to "Change units or size of units of cyclic values in widgets").

→ View  ----> System of units.
→ Click on measured variable.

Defined units and size of units are ticked (e.g. by the previously selected system of units).
→ Click on units oder size of units to active or deactivated (ticked or unticked).

• Changes in the measured variables will remove the tick in front of the (previously set) system of units.
• If the system of units is re-selected after changes to the measured variables were implemented, all units or sizes of units are reset to the default values.

Change units or size of units of cyclic values in widgets

Many widgets have an icon that can be used to change the unit or the size of the unit directly and only for this measured variable using a context menu.

Figure 16: Select units in widgets

→ Place mouse pointer on widget.
Icon appears.
→ Click on .
→ Select unit (tick is placed in front of unit).

⚠️ Changing the unit or the size of the unit in the widget has no influence on the specification of the system of units.
"Reset" in the context menu will set the unit that is selected by the system of units or in the area of the measured variable.
Change units or size of the unit of process values of the graphs in the navigation area

The units or size of the unit in the process values for the graphs can be changed using a drop-down list in the navigation area.

![Image of Communicator Type 8920](image)

*Figure 17: Select units in the navigation area*

→ Click on unit.
→ Select unit in drop-down list.

### 8.2.3 Keep or remove graph when connection is interrupted

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
</table>
| ![Options / Remove graphs with device](image) | **Options / Remove graphs with device** | If the connection to the device or product is interrupted, the following selection is available:  
Keep or remove graph.  

Note: Made settings are ticked.

Remove graph when connection to the device or product is interrupted (function is not ticked), see example "Figure 18: Remove graphs with device":

→ Click on **Options**
→ Click on **Remove graphs with device** (ticked).

Keep graph when connection to the device or product is interrupted (function is ticked):

→ Click on **Options**
→ Click on **Remove graphs with device** (tick is removed).
**Communicator Type 8920**

**Operation and functions**

---

**Figure 18:** Remove graphs with device

Time span during that the connection to the device is interrupted.
8.2.4 **Manage licenses**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
</table>
|      | **Options / License manager ...** | Displays the assigned licenses and the corresponding activated functions.  
• Add further licenses. |

8.2.5 **Activating password protection or define password**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Options / Password manager</strong></td>
<td>Define a password to protect settings.</td>
</tr>
</tbody>
</table>

Following installation of the communicator, password protection is deactivated. The set user level is the level of the installer.

![Figure 19: Current user level](image)

User level when starting the communicator:

<table>
<thead>
<tr>
<th>Password set for</th>
<th>Set user level when starting</th>
</tr>
</thead>
<tbody>
<tr>
<td>No password set</td>
<td>Installer</td>
</tr>
<tr>
<td>Installer</td>
<td>Advanced user</td>
</tr>
<tr>
<td>Advanced user</td>
<td>User</td>
</tr>
</tbody>
</table>

*Table 6: User level when starting the communicator*

The user level can be changed by clicking on the symbol of the current user level.
Password manager:

→ Click on **Options**.

→ Click on **Password manager...**.

![Password manager](image)

**Figure 20: Password manager**

The password manager can be used for assigning rights to users by passwords.

<table>
<thead>
<tr>
<th>Icon</th>
<th>User level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="User icon" /></td>
<td>User</td>
<td>Standard user, read access, can change a few values</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No password</td>
</tr>
<tr>
<td><img src="image" alt="Advanced user icon" /></td>
<td>Advanced user</td>
<td>Can change specific values and carry out simple calibrations. Standard password: 5678 (can be changed by installer)</td>
</tr>
<tr>
<td><img src="image" alt="Installer icon" /></td>
<td>Installer</td>
<td>Has all rights for operating the Communicator. Standard password: 1946 (can be changed by installer)</td>
</tr>
<tr>
<td><img src="image" alt="Bürkert icon" /></td>
<td>Bürkert</td>
<td>Only for Bürkert-Service.</td>
</tr>
</tbody>
</table>

**Table 7: User level**
8.3 Information and Help

8.3.1 Help

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Help / Help</td>
<td>Displays these operating instructions.</td>
</tr>
</tbody>
</table>

8.3.2 Driver versions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Help / Driver versions</td>
<td>Displays the installed devices or products, the corresponding driver versions and the supported types.</td>
</tr>
</tbody>
</table>

8.3.3 Software information and manufacturer's address

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Help / About...</td>
<td>Displays version number and manufacturer’s address</td>
</tr>
</tbody>
</table>

8.3.4 Logbook file

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Tools / Open logbook file</td>
<td>Open a file...</td>
</tr>
</tbody>
</table>
8.4 büS network configuration

All devices or products connected via an interface and their büS network configuration are displayed in the büS-Map in the communicator.

If the interface is selected in the navigation area, the following tabs appear:

- **Overview**: Shows all devices and products connected to the interface with the current values.
- **büS-Map**: Shows all devices and products connected to the interface with the respective inputs and outputs and the büS network configuration.

The user can edit the büS network configuration here.

Displaying the overview:

→ Select interface in the navigation area.

✓ The application area shows all devices and products connected to the interface.

8.4.1 büS-Map

→ Select interface in the navigation area.

→ Activate büS-Map tab.

✓ The application area shows all devices or products connected to the interface and the büS network configuration.
New connection

Tool bar

Active connection

Output

Input

Devices

Figure 22: büS-Map

<table>
<thead>
<tr>
<th>Icon</th>
<th>Command or description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Display or do not display connections with lines.</td>
</tr>
<tr>
<td></td>
<td>AutoFit</td>
</tr>
<tr>
<td></td>
<td>The büS-Map is fitted into the view (application area).</td>
</tr>
<tr>
<td></td>
<td>Automatic layout</td>
</tr>
<tr>
<td></td>
<td>The devices or products are automatically arranged.</td>
</tr>
<tr>
<td></td>
<td>Save screenshot to file.</td>
</tr>
<tr>
<td></td>
<td>Reload the büS-Map.</td>
</tr>
<tr>
<td></td>
<td>Enlarge the view.</td>
</tr>
<tr>
<td></td>
<td>Reduce the view.</td>
</tr>
<tr>
<td></td>
<td>Delete all connections.</td>
</tr>
<tr>
<td></td>
<td>Delete selected connection.</td>
</tr>
</tbody>
</table>

Table 8: Tool bar
### 8.4.2 Processing büS network configuration with büS-Map

**Switching to the büS-Map:**

- Select interface in the navigation area.
- Activate büS-Map tab.

✓ The application area shows all devices or products connected to the interface and the büS network configuration.

**Displaying possible connections:**

- Place mouse pointer on an input or output.

✓ The possible connections are displayed in blue.

**Making connections:**

**Option 1:**
- Use Drag-and-drop to make a connection.

✓ The connection is displayed as a dotted line.
- Click apply changes.

✓ The changes are accepted and the affected devices are restarted.

**Option 2:**
- Click on + on one input.
- Select connection.

✓ The connection is displayed as a dotted line.
- Click apply changes.

✓ The changes are accepted and the affected devices are restarted.

---

**Figure 23:** Make connection, option 2, example
Deleting connections:
→ Select connection.
→ $f$ Click or press Rem key on keyboard.
→ Click apply changes.
✓ The connection is deleted and the affected devices are restarted.

⚠️ The devices can be positioned on the view using Drag-and-drop. This arrangement is not maintained during updates.
8.5 Customize desktop

The user can customize the desktop according to his preferences.

The following elements are possible:

- Process values of the devices or products as a widget
- Graphical display of process values (graph) of devices or products
- Graphical elements
- Texts

All elements can be generated using the icons in the tool bar.

⚠️ Widgets or elements can only be moved (drag-and-drop) or changed if the tool bar is open.
8.5.1  Edit or Backup desktop ( ✂️ or ⌨️)

Edit desktop:
→ Click on ✂️.
✓ The tool bar is open.
→ Customize desktop.

Backup desktop:
→ Click on ⌨️.
✓ Desktop is pinned and the tool bar is closed.

8.5.2  Insert process value as a widget 📈

→ ✂️ Click on desktop.
→ Click on ✂️.
✓ The tool bar is open.
→ Click on ⌨️
→ Select device or product.
→ Select configuration.
→ Select process value.
✓ The process value is placed on the desktop.

Figure 25: Insert widgets
8.5.3 Insert graphical elements or texts  

→ Click on 📁.

✔ The tool bar is open.

![Insert a graphic or picture from a file](image1)

Insert a graphic or picture from a file:

→ Click on 📁.

→ Click on Paste picture from disk...

A dialog field appears:

→ Select the location containing the graphic or picture.

→ Select the graphic or picture.

✔ Graphic or picture is placed on the desktop.

Insert a device picture:

→ Click on 📁.

→ Click on Paste device picture...

→ Select the device picture.

✔ Device picture is placed on the desktop.

![Insert text field](image2)

Insert text field:

→ Click on 📁.

✔ Text field is placed on the desktop and the text cursor indicates the insertion position.

→ Enter text.
Insert chart

→ Click on .

☑ Empty chart is placed on the desktop.

Display values in the chart:

→ Click on .

→ Select device or product.

→ Select configuration.

→ Select process value.

☑ The process value is placed in the chart.

Insert shapes

→ Click on .

→ Select shape.

☑ Shape is placed on the desktop.

8.5.4 Change widgets, graphical elements or texts

→ Click on widget, graphical element or text.

Display icons and handles are shown at the widget, graphical element or text.

![Figure 26: Display icons and handles](image-url)
Change arrangement or size
→ Click on a graphical element.

Increase or reduce element
→ Click and hold and change size.

Note: If only one handle is provided, the element can only be changed proportionally.

Rotate element
→ Click on .
✓ The element is rotated clockwise by 90°.

Bring element to front
→ Click on .
✓ The element is in the foreground.

Send element to back
→ Click on .
✓ The element is in the background.

Delete element from desktop
→ Click on .
✓ The element is deleted.
Change line width and colors of shapes
→ Click on shape (graphical).

1 — Change outline width

→ Click on 1 — .
→ Select line width in drop-down list.
☑ The element is changed.

Change contour color

→ In ☐, click on ☐ .
→ Select color in drop-down list.
☑ The element is changed.

Change fill color

→ In ☐, click on ☐ .
→ Select color in drop-down list.
☑ The element is changed.
Change color of text and text field

→ Click on text field.

Change text color

→ In , click on .
→ Select color in drop-down list.
✓ The element is changed.

Change text field color

→ In , click on .
→ Select color in drop-down list.
✓ The element is changed.
Change representation of widgets
→ Click on a widget.

Change bar color
→ Click on .
→ Select color in the drop-down list.
✔ The element is changed.

Change widget style
→ Click on .
→ Each click changes the representation of the widget.
✔ The element is changed.

Adjust value range (min/max)
→ Click on .
A dialog field appears:
→ Input minimum and maximum value.
→ Click on OK.
✔ The value range is adjusted.
8.6 Graph

Display graph in the application area:

→ Select device or product in the navigation area.

✔ The process values for the selected device or product are displayed.

→ Select process value in the application area.

✔ The box is checked and the selected process value appears in the navigation area in the Graph folder.

→ Click on graph.

✔ The graph is displayed in the application area.

Remove graph from the application area:

→ In the Graph folder click on .

✔ The graph is removed from the application area.
8.6.1 Auto-fit graph

Possible with:

- **AutoFit** button
- Change display multiplier
- Change size of the unit

Auto-fit graph or roll graph and view

Selection of possible views by activating the buttons:

- **AutoFit**: Graphs are auto-fit to view, i.e. all values are displayed in the view. Possible for x-axis and y-axis.
- **Roll**: Graphs roll, i.e. the graphs move on the view (time axis moves). Only possible for x-axis.

Additional functions:

Graphs are frozen.

→ Deactivate all buttons.

![Buttons for x-axis](image)

![Buttons for y-axis](image)

*Figure 28: Auto-fit graph*
Auto-fit graph in view with display multiplier or size of unit

Two graphs fitting options are available so that graphs with different measured variables can be displayed in one view.

- Change display multiplier.
- Change size of the unit.

Change display multiplier:

→ Click on display multiplier in the navigation area.

→ Select display multiplier in drop-down list.

Change unit:

→ Click on unit in the navigation area.

→ Select unit in drop-down list.

---

Figure 29: Change display multiplier or unit of graph
8.6.2 Scale axes

Enlarge axis scaling
→ Click on +.

Reduce axis scaling
→ Click on −.

8.6.3 Change graph color
→ Click on color field in the navigation area.
A drop-down list opens.
→ Select color.

Figure 30: Change graph color
8.6.4  Save graph in a logfile (database)

→  Click on  

A dialog field appears.

→  Select value.

→  Select file format (CSV file or EDIPDB file).

→  In CSV file: select values.

→  Click on **Save**.

→  Select the location where the database is to be saved.
8.6.5 Open or close databases

Open database

→ Right click on graph in the navigation area.
A context menu appears.
→ Click on Load database...
A dialog field appears.
→ Select the location containing the database.
Note: The file type is (*.edipdb).
✓ The database is displayed in the navigation area underneath a new folder with its file name.

Close database

→ Right click on database in the navigation area.
A context menu appears.
→ Click on Disconnect interface
✓ The database is removed.
8.6.6 Other functions

| x | - | + | Auto-Fit | Roll | × | ☐ | ☐ |
| y | - | + | Auto-Fit | | | | |

Delete values from view

→ Click on ×.

☑ All values up to the current point in time are deleted from the application area.

Copy screen shot of the view to clipboard

→ Click on ☑.

→ Insert clipboard content in a different program (e. g. Word).

9 UNINSTALL COMMUNICATOR

Procedure:

→ Select the "Uninstall program" item in the system control (via "Start / System control / Programs / Uninstall programs").

→ Click on "Bürkert Communicator" and click on the **Uninstall** button.

→ Run the deinstallation as suggested by the wizard and complete the process by rebooting Windows.
## 10 GLOSSARY

<table>
<thead>
<tr>
<th>Graph</th>
<th>Name of type of display in the application area. The process values of a device or product can be displayed as a curve in a coordinate system.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphs</td>
<td>Graphical display of process values of a device or product in a coordinate system.</td>
</tr>
</tbody>
</table>